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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©August 2010

Trademarks
AMD® Athlon™ is a trademark of Advanced Micro Devices, Inc.
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R&TTE Directive

This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

\ A/
2§
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A or 18.5V, 3.5A (65 Watts) minimum AC/DC Adapter.

CAUTION

This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.

Vi

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer Do not place it on an unstable | Do not place anything heavy
to any shock or vibration. surface. on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose it to excessive Do not leave it in a place Don’t use or store the com- Do not place the computer on
heat or direct sunlight. where foreign matter or mois- | puter in a humid environment. | any surface that will block the
ture may affect the system. Vents/Fan Intakes.
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

Vi
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Power Safety
The computer has specific power requirements:

 Only use a power adapter approved for use with this computer.

ﬁ * Your AC/DC adapter may be designed for international travel but it still requires a steady,
Power Safety uninterrupted power supply. If you are unsure of your local power specifications, consult
Warning your service representative or local power company.
Before you undertake  The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong
any upgrade proce- is an important safety feature; do not defeat its purpose. If you do not have access to a
dures, make sure that compatible outlet, have a qualified electrician install one.
SRR EEESURERE .« When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
power, and 'dISCOI‘l- its wire
nected all peripherals ' .
e e @ * Make sure the socket and any extension cord(s) you use can support the total current load
telephone lines). It is of all the connected devices.
advisable to also re- « Before cleaning the computer, make sure it is disconnected from any external power sup-
move your battery in plies (i.e. AC/DC adapter or car adapter).
order to prevent acci-
dentally turning the
machine on. Do not plug in the power Do not use the power cord if | Do not place heavy objects
cord if you are wet. it is broken. on the power cord.

VI
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

» Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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Battery Precautions

« Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

 If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

SN
L&

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

Xl
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

X1l
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

« Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

¢ Use a chair with a back and adjust it to support your lower back comfortably.

« Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

« Take periodic breaks if you are using the computer for long periods of time.

Remember to:

e Alter your posture frequently.

»  Stretch and exercise your body several times a day.

»  Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system is not in use.

XV
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

» Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, card reader), TouchPad & Mouse, Audio & Printer.

e Chapter 3  The computer’s power saving options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 6  Instructions for upgrading your computer.

» Chapter 7 A quick guide to the computer’s Wireless LAN, PC Camera, 3.75G/HSPA and Bluetooth mod-
ules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

* Appendix B Information on the ATI Video driver controls.

» Appendix C The computer’s specification.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a /Z of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark . remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
tors foatiroe. e <™ | may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Model Differences

This notebook series includes different model types which differ slightly in design style. Note that your model’s
appearance and/or color may appear slightly different from those pictured throughout this manual.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find that this manual refers to the Windows 7
operating system

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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System Startup

Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

PobNPE

o

4

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the
Start menu in Windows. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 -4 System Startup



System Map: LCD Panel Open

\ A/
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the 3.75G/
HSPA/WLAN/Bluetooth
modules, and check the LED
indicator or on-screen icon to
see if the modules are pow-
ered on or not (see
/

).

=

No

0N

Quick Start Guide

Figure 1 -2
LCD Panel Open

Built-In PC Camera
(Optional)

LCD

Power Button

Hot Key Buttons
LED Status
Indicators (see
Table 1-2,0n
page 1 - 6)
Keyboard

Built-In Microphone
Touchpad &
Buttons

(8]

Touchpad Buttons
(valid operation area)

System Map: LCD Panel Open 1-5
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LED Indicators

The LED indicators on the computer display helpful
information about the current status of the computer.

Icon

Color

Description

Icon Color

Description

O 6 6 0 6

Orange

DC Power is Plugged In

Green

The Computer is On

Blinking Green

The Computer is in Sleep
Mode

Orange

The Battery is Charging

Green

The Battery is Fully Charged

Blinking Orange

The Battery Has Reached
Critically Low Power Status

Green Scroll Lock Activated (to activate

9 press Fn & Scr Lk)

e Green Caps Lock Activated

6 Green Number Lock Activated

@ Green Hard Disk Activity

Green The (optional) Wireless LAN

Module is Powered On

0 Orange The (optional) Bluetooth Module

9 is Powered On

Table 1 -1 -LED Power Indicators

1-6 LED Indicators

Table 1 - 2 - LED Status Indicators
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Hot Key Buttons

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle
the Silent Mode on/off with one quick button press.

Hot Key Function

® 2] o

Toggle *Silent Mode (for power saving)

Activate the Default Internet Program

®

Activate the Default E-Mail Browser (Note that in Windows 7 without Outlook/Outlook
9 Express installed this button has no function. If Outlook/Outlook Express are installed
then the button will activate the application)

Table 1 - 3 - Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

Hot Key Buttons 1 -7
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4

Other Keyboards

Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See

If your keyboard is dam- || Table 1 - 4, on page 1 - 9 for full function key combination details.
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-

matically. However spe- _
cial  functions/hot-keys Play/Pause Key

unique to the system'’s i
regular keyboard may not Numerical Keypad

work.

NumLk &
ScrLk Keys

3.75G/HSPA
Module Power
Toggle Key

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta- /
tus.

Figure 1 - 3 - Keyboard

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1 - 8 Keyboard



Function/Hot Key Indicators

Quick Start Guide

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Keys Function Keys Function
Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F7 Display Toggle
3.75G Module Power Toggle*
En + Fn + F8/F9 Brightness Decrease/Increase
Fn+F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle
Turn LCD Backlight Off .
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+Fl11 WLAN Module Power Toggle
Fn+F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle
Fn +F4 Sleep Toggle **Silent Mode Toggle
Volume Decrease/Increase *Make sure that Wireless is ON in the Windows Mobility Center to ensure
proper wireless function key behavior (see page 3 - 12).
Fn + F5/F6 . . .
**When enabled, Silent Mode will reduce fan noise and save power
consumption. Note this may reduce computer performance.

Table 1 - 4 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 -9
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Figure 1 - 4 System Map: Front & Left Views

Front & Left Views

1. LED Power Indica- 0
tors (see Table 1 -
1,o0n page 1 - 6)

2. DC-InJack
3. External Monitor
Port
4. RJ-45 LAN Jack
5. HDMI-Out Port
6. 2*USB 2.0 Ports
7. Vent/Fan Intake/
Outlet .
8. Multi-In-1 Card Multi-In-1 Card Reader
Reader The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / RSMMC
*See “HDMI Audio Con- SD (Secure Digital) / Mini SD
figuration” on page B - 14 MS (Memory Stick) / MS Pro / MS Duo

for more information on the
audio settings for HDMI.

1-10 System Map: Front & Left Views
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System Map: Right & Rear Views Figure 1-5

Right & Rear Views

1. Microphone-In
o0 © (1) Jack
(5] 2. Headphone-Out
Jack
3. USB 2.0 Port
4. Optical Device
Drive Bay (for CD/

DVD Device)
2N 5. Security Lock Slot
/Q\ 6. Battery

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption)
you may push the end of a straightened paper clip into the emergency eject hole. Do not
use a sharpened pencil or any object that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the system is accessing it. This may
cause the system to “crash”.

Disk Eject Warning

Don't try to eject a CD/DVD while the system is accessing it. This may cause the system
to “crash”. Stop the disk first then eject it, or press the stop button twice.

System Map: Right & Rear Views 1 - 11
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Figure 1 - 6 System Map: Bottom View

Bottom View

1. Battery 2 0
2. Component Bay Battery Information
Cover
3. Vent/Fan Intake/ Always completely dis-
Outlet charge, then fully charge, a
4. Hard Disk Bay new battery before using it. 9 9
Cover Completely discharge and 9
5 3.75G USIM Card charge the battery at least

. once every 30 days or after
Cover (Optional) about 20 partial discharges.

6. Speakers See “Battery” on page 3 - e e
2 for full instructions.
2§

CPU

The_CPU is not a user A
serviceable part. ﬂ\

Overheating Bottom Covers

To prevent your comput- If your model includes the 3.75G option then a
er from overheating small cover 5 to enable you to access the
make sure nothing blocks module’s USIM card will be included (see
the Vent/Fan Intake while ).

the computer is in use.

1-12 System Map: Bottom View
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 7 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

.|
System Map: Bottom View 1 - 13
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Video Features

You can configure display options from the Display control panel in Windows, and from the ATI Catalyst Con-
trol Center as long as the appropriate video driver is installed. For more detailed video information see “AT]
Video Driver Controls” on page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:

1. Click Start and click Control Panel.

2. Click Display (icon) - In the Appearances and Personalization category.

3. Click Adjust Screen Resolution/Adjust resolution.

OR

4. Alternatively you can right-click the desktop and select Screen resolution (see right).

5. Use the dropbox to select the screen Resolution @ (Figure 1 - 8 on page 1 - 15).

6. Click Advanced settings @ (Figure 1 - 8 on page 1 - 15) to bring up the Advanced properties tabs.

To access the ATI Catalyst Control Center:

1. Click Start and click All Programs (or just click Start and select ATI CCC @ Figure 1 - 8 on page 1 - 15).

2. Click Catalyst Control Center.

3. Click ATI CCC (Advanced/Wizard) @ (Figure 1 - 8 on page 1 - 15).

OR

4. Right-click the desktop and select Catalyst(TM) Control Center.

OR

5. Double-click the taskbar icon © (Figure 1 -8 on page 1 - 15). Note that you can add the ATl icon to the
taskbar (Enable System Tray Menu) from the Catalyst Control Center’s Options > Preferences menu @.

1 - 14 Video Features
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Screen Resolution & ATI Catalyst Control Center

(3]
(4] (6]

(5]

Figure 1 - 8 - Screen Resolution & ATI Controls

Video Features 1 - 15
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 12) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery” on page 3 - 2.

Figure 1 - 9 - Power Options

1-16 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
Multi-In-1 Card Reader
TouchPad and Buttons/Mouse
Audio Features

Adding a Printer

. |
Overview 2 - 1
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Hard Disk Drive

SN
’Ll‘ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
S e el on page C - 2) with a height of 9.5 mm.

Eif:pizzn?i th%f'”‘e;c’,‘jr' The hard disk is accessible from the bottom of your computer as seen below. For fur-
computer please ensure ther details see “Upgrading the Hard Disk Drive” on page 6-4.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also

ensure that all peripher-

al cables, including

phone lines, are discon-

nected from the comput-

er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “Storage” on page C - 2). The Sound Volume
optical device is usually labeled “Drive D:” and may be used as a boot device if Adjustment
properly set in the BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto | gows. Click the Volume
the disc tray with label-side facing up (use just enough force for the disc to click onto | icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | check the setting (see
are ready to start. The busy indicator @ will light up while data is being accessed, | Audio Features® on

. L ) . . . 2-11).
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt- page )
ed, insert an object such as a straightened paper clip into the emergency eject hole
to open the tray.
©toop Y Figure 2 - 2

Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

3[:1’: Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

gjecta CD (e.g-due to I\ RR{elI[e)WWTsls)

an unexpected power

LIEERT RS CIER g EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERRERCIESRERE  «  Use a clean, soft, dry cloth to remove dust or fingerprints.
fﬁi?'?hfirﬁﬁgrg%ﬁreﬂ'ﬂ « Do not write on the surface with a pen.

T SENEE el ¢ Do not attach paper or other materials to the surface of the disc.
JNeR e R ETEl ¢ Do not store or place the CD or DVD in high-temperature areas.
SRS IEIER o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SO S eSS . Do not bend the CD or DVD.

db lodged i -
;ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes:

1.
2.

3.

Go to the Control Panel

Double-click Device Manager (Hardware and Sound), then click the + next to
DVD/CD-ROM drives.

Double-click on the DVD-ROM device to bring up the Properties dialog box, and
select the DVD Region (tab) to bring up the control panel to allow you to adjust the
regional code.

DVD region detection is device dependent, not OS-dependent. You can select
your module’s region code 5 times. The fifth selection is permanent. This cannot
be altered even if you change your operating system or you use the module in
another computer.

* Region 1- USA & Canada

» Region 2 - Western Europe, Japan, South
Africa, Middle East & Egypt

» Region 3 - South-East Asia, Taiwan, South
Korea, The Philippines, Indonesia, Hong Kong Figure 2 - 3

+ Region 4 - South & Central America, Mexico, DVD Region Codes
Australia, New Zealand

» Region 5 - N Korea, Russia, Eastern Europe,
India & Most of Africa

* Region 6 - China

Optical (CD/DVD) Device 2 - 5
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Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 -4
Left View

1. Card Reader

Multi-In-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

* MMC (MultiMedia Card) / RSMMC
» SD (Secure Digital) / Mini SD
* MS (Memory Stick) / MS Pro / MS Duo

*Note: The PC adapters are usually supplied with these cards.

2 - 6 Multi-In-1 Card Reader
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TouchPad and Buttons/Mouse

_ . e
The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

. . ternal mouse your op-
Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you erating system may be

can configure the functions by double-clicking the TouchPad driver icon  on the able to auto-configure
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer your mouse during its
motion and sensitivity options to your preferences. You will find further information installation or only en-

) able its basic functions.
at www.synaptlcs.com. Be sure to check the

device’'s user docu-
mentation for details.

Figure2-5

Mouse Properties

TouchPad and Buttons/Mouse 2 - 7
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4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure 2 - 6
Mouse Properties -
Device Settings

Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Mouse (Hardware and Sound).

Click Device Settings (tab) and click Settings.

Use the menu tree on the left to access the user configurable settings.

-
O

PonNE

2 - 8 TouchPad and Buttons/Mouse
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the

TouchPad surface and slide both fingers in the direction required (in a straight con-

tinuous motion).

Figure 2 -7
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 8

Zooming Gesture

. |
TouchPad and Buttons/Mouse 2 - 9
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-9
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

Figure 2 - 10
Flick/Press
Gesture

. |
2 - 10 TouchPad and Buttons/Mouse
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Audio Features

You can configure the audio options on your computer from the Sound  control -
panel in Windows, from the HD VDeck icon on the desktop ~ or VIA HD Audio Sound Volume
Deck control panel [2%] via vo audio peck S T

The sound volume level
The volume may also be adjusted by means of the Fn + F5/F6 key combination. is set using the volume

control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to

check the setting.

Figure 2 - 11
VIA HD Audio Deck

Audio Features 2 - 11
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Expert Mode will allow you to access more advanced configuration menus.

Figure 2 - 12
VIA HD Audio Deck
(Expert Mode)

See “HDMI Audio Configuration” on page B - 14 for more information on the au-
dio settings for HDMI.

2 - 12 Audio Features
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

arwd

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer’'s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Adding a Printer 2 - 13

4

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

L functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
e The Power Sources best to refer to the user’s

manual of your operat-

» Turning On the Computer :
ing system.

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
 Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources
Z The computer can be powered by either an AC/DC adapter or a battery pack.

Wake On LAN
AC/DC Adapter

If you need your system
setup to Wake ON LAN, || Use only the AC/DC adapter that comes with your computer. The wrong type of AC/

then see the instructions ; ;
D (o7 TN S DC adapter will damage the computer and its components.

up” on page 8 - 18. 1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer P

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel. Forced Off

: : If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s G 2 T ]

Shthown hot-key button when it is pressed _for I_ess than 4 seconds (pressing and | yqy combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power
Power Options in the Windows control panel to configure this feature. button for 4 seconds, or

longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS’s

or system problems. “Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

.|
Turning On the Computer 3 - 3
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4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

3 - 4 Power Plans



Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans

Power Management

Figure 3-2

Power Plans

Power Plans 3 - 5
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Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.
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Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

-
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Figure 3- 3
Start Menu Power
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Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
Protection the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3-4
Power Options
Define Power
Buttons

.|
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, Z
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

Press the Power Button will wake the system up.

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) Table3-1
Hibernate Press the Power Button Resuming
Orange (AC/DC adapter) .
Operation

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

4

4 3.75G/HSPA
Modules & System
Power Button Wake Up

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down Note that the 3.75G mod-

hot key button when it is pressed for less than 4 seconds (pressing and holding the power ules DO NOT support
button for longer than this will force the computer to shut down). system wake up on
3.75G/HSPA modem ac-
tivity.

Configuring the Power Buttons 3 - 9
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Energy Star Power Saving

Z This system supports Energy Star power management features that place comput-
TEsldsEr eom ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. If you want to enable Energy Star power saving then follow these in-

If the taskbar icon does structions:

not appear then click the
taskbar arrow and select
Customize.

=

Right-click the taskbar icon n (see sidebar).

Select Power Conservation Modes. |  powerConsenatondodes |

3. Select Energy Star to use the Energy Star power management and override other
power saving settings.

n

O

Select Show icon and
notifications alongside
the Hotkey icon and
click OK. The [ icon
will now appear in the
taskbar.

AN
Ik

Conservation Modes

The default Energy Star setting
will result in maximum power sav-
ing, but with the possible loss of

some performance.

Setting the mode to Balance will

give power saving matched with
Figure 3-5 performance.

Energy Star Menu Performance will give optimum

computer performance but with

less power conservation.
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Low Battery
Battery Power Warning

Your computer’s ba_ttery power _is depender_lt upon many factors, includin_g the pro- EEFFES S i G
grams you are running, and peripheral devices attached. You can set actions to be RS ETAEEE
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from FeeliEeamEERAelb/e
power plan Change plan settings > Change advanced power settings (see Figure JaSaaERE RS

_ _ or save your work, oth-
3-2onpage3 5)' erwise, the unsaved

data will be lost when

Click the battery icon [ in the taskbar to see the current battery level and charge the power is depleted.

status.

Figure 3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
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Conserving Battery Power

7\£X< » Use a power plan that conserves power (e.g Power saver), however note that
Wireless Hot Keys this may have an affect on computer performance.
0t e ¢ Lower the brightness level of the LCD display. The system will decrease LCD
function keys will not func- brightness slightly to save power when it is not powered by the AC/DC adapter.

i ly if Wireless i . o
Bl « Reduce the amount of time before the display is turned off.

* Close wireless, Bluetooth, modem or communication applications when they are
not being used.

dows Mobility Center
control panel.

2‘”“‘9'“‘?'2? Wl - Disconnect/remove any unnecessary external devices e.g. USB devices,

the WLAN module is pow- ExpressCards etc.
ered on, however if wire-

less is OFF in the Mobility

Center, the module will not

be powered on.

4

Windows Mobility

Center
Make sure that Wireless is

ON in the Mobility Center to
ensure proper function key
behavior.

The Windows Mobili-
ty Center control pan-

el provides an easy
point of access for in-
. formation on battery

Figure 3-7 status, power plans
Windows Mobility used and wireless de-

Center ) ) _ _ vice status etc.
Make sure Wireless is ON to ensure proper function key behavior.

3 - 12 Battery Information



Power Management

Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 6 for information on the battery charge status, and to “Energy Star
Power Saving” on page 3 - 10 for more information on how to maintain and prop-
erly recharge the battery pack.)

.|
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Proper handling of the Battery Pack
?ﬁl’: * DO NOT disassemble the battery pack under any circumstances
« DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

2AN\Z
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t

turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3-8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure 3-9
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure 3-10
Power Options
Advanced Settings -
Battery

* Low battery levels = 0%

 Critical battery Levels = 1%

» Low battery action = Do Nothing

« Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of
the computer’s subsystems. The system takes advantage of some newer hardware components for which the lat-
est versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system
components won’t be auto-configured with an appropriate driver or utility during operating system installation.
Instead, you need to manually install some system-required drivers and utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper
operation of the computer. Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that
the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, 3.75G/HSPA, PC Camera and Combo Bluetooth
& WLAN modules are provided in “Modules & Options” on page 7 - 1.

Make sure any modules (e.g. WLAN, PC Camera, 3.75G/HSPA or Bluetooth) are ON before installing the ap-
propriate driver.

What to Install 4 - 1
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual
disc into the DVD drive and click Install Drivers/Op-
tion Drivers (button).

Follow the instructions to install the driver. Alterna-
tively click Start, navigate (Browse..) to the execut-
able file and then follow the manual setup instructions.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you
should note down the drivers as you install them).

3. Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Note: If you need to reinstall any driver, you should uninstall the
driver first.

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation
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Manual Driver Installation

Click Browse CD/DVD (button) in the Drivers Install-
Video Page 4 -5 er application and browse to the executable file in the
appropriate driver folder.

Driver for Windows 7 Page #

LAN Page 4 - 6
TouchPad Page 4 -6 Windows Update
CardReader Page 4 -6 After installing all the drivers make sure you enable
Hot Key Page 4-6 Windows Update in ordel_r tc_) get all the latest secu_rlty
updates etc. (all updates will include the latest hotfixes
Audio Page4-6 from Microsoft). See “Windows Update” on page 4 -
AMD AHCI Driver Page 4 - 7 7 for instructions.
Wireless LAN Module Page 7 - 2
PC Camera Module Page 7 -8
3.75G/HSPA Module Page 7 - 19
. Page 4 -7
AMD AHCI Driver Page 7 - 26
Bluetooth Module (Driver required Page 7- 28

for combo module only)

Table 4 - 1 - Driver Installation

Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

User Account Control

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

4 - 4 Driver Installation
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New Hardware Found Driver Installation Procedure

If you see the message “New Hardware Found” dur-  Insert the Device Drivers & Utilities + User’s Manual
ing the installation procedure (other than when out- disc into the DVD drive and click Install Drivers (but-
lined in the driver install procedure), click Cancel ton).

to close the window, and follow the installation proce-

dure. Video
1. Click 1.Install Video Driver > Yes.
4 2. Click Next > Install (button).

Driver Installation General Guidelines 3. Click the Express (or Custom if you prefer to
The driver installation procedure outlined in this Chapter manually configure the driver installation set-
(and in Chapter 7 Options & Modules), are accurate at tings) button and click Next.
the time of going to press. 4. Click Accept (button) and click Yes.
Drivers are always subject to upgrade and revision so 5. Click Finish > Yes to restart the computer.

the exact procedure for certain drivers may differ slight- . . . . .
ly. As a general guide follow the default on screen in- Note: After installing the video driver go to the ATI

structions for each driver (e.g. Next > Next > Finish) Catalyst Control Center to adjust the video settings to

unless you are an advanced user. In many cases a re- the highest resolution.
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or
3.75G/HSPA) are ON before installing the appropriate
driver.

. |
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LAN

1. Click 2.Install LAN Driver > Yes.
2. Click Install.

3. Click Finish.

TouchPad

1. Click 3.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Install > Finish.

Hot Key

1. Click 5.Install Hotkey Utility > Yes.

2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

Audio

1. Click 6.Install Audio Driver > Yes.

2. Click Next.

3. Click the button to agree to the license and
click Next.

4. Click Next > Next > Next.

5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

(See Over)
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AMD AHCI Driver

If you have enabled AHCI mode in the BIOS (see
“SATA Mode Selection (Advanced Menu)” on
page 5 - 9), and have not installed the AHCI driver at
system installation, then you should do so now as per
the instructions below:

1. Insert the Device Drivers & Utilities + User’s
Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 4.Install AMD AHCI Driver > Yes.
Click Next > Install.

Click Finish > Finish to restart the computer.
Click OK to reboot the system after the driver
has been installed and the system restarted.

ok~ wnN

To uninstall the AMD AHCI driver see the instruc-
tions in “Uninstalling the AMD AHCI Driver” on
page 8 - 12.

Drivers & Utilities

4

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.

2.
3.

Click Start, and click Control Panel (or point to
Settings and click Control Panel).

Click Windows Update (System and Security).
Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.

Driver Installation 4 - 7
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Windows Experience Index

After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index:

1. Click Start, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience Index).

3. Click “Rate this computer”.

4. The computer will take a few minutes to assess
the system performance.

5. Close the control panel.

Optional Drivers

See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu
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Wireless LAN Module 3.75G/HSPA Module
See the introduction in “Wireless LAN Module” on See the introduction in “3.75G/HSPA Module” on
page 7 - 2, and check the installation procedure. page 7 - 15, and check the installation procedure for

the appropriate module.
PC Camera Module

See the introduction in “PC Camera Module” on Bluetooth Module

page 7 - 7, and check the installation procedure. A driver is only required for the Combination
Wireless LAN & V3.0 Bluetooth. See “Bluetooth
Combo Driver Installation” on page 7 - 28.

The operating system is the default setting for Blue-
tooth control for the standard V2.0 Bluetooth mod-
ule in Windows 7 and does not require a driver. See
“Standard Bluetooth Configuration in Windows 7”
on page 7 - 36 for instructions.

Driver Installation 4 - 9
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Chapter 5: BIOS Utilities "

OverVieW BIOS Settings
Warning
This chapter gives a brief introduction to the computer’s built-in software: _
Incorrect settings can
Diagnostics: The POST (Power-On Self Test) ;a;ffm)t/,zf ng ifr?jec:o
mistakes, return to Set-
Configuration: The Setup utility up and restore the Set-

If your computer has never been set up, or you are making important changes to the [ s SIERTIUE S

system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

. |
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The Power-On Self Test (POST)

Z Each time you turn on the computer, the system takes a few seconds to conduct a
POST Screen POST, including a quick test of the on-board RAM (memory).
;'E'F(,?Jst;r:grma""” As the POST proceeds, the computer will tell you if there is anything wrong. If there

3.Memory status is a problem that prevents the system from booting, it will display a system summary

4.Enter Setup prompt | and promptyou to run Setup.
appears only during . . .
POST If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
Note: The POST screen
as pictured right is for

Phoenix TrustedCore{tm} HE

guideline purposes only. Copyright 1985-2006 Phoenix Technologies Ltd.
11 Right= Reserved

The POST screen on BIDUS Revision ”"..""Q

your computer may ap- KEC/EC Firmmare Bevision *hdkkkkks

pear slightly different. If CPU0 = AMD Athlon(tm) X2 I ore QL-62

you disable the Boot- 632K System RAM Passedl

. . . 3838M Extended FIM Passed

time Diagnostic Screen, 1091 KB L9 Cache

the POST screen will not System BIOS shadowed
Video BIOS shadowed

appear' ATAPI CD-ROM: TSSTcorp CDDVDW TS-L633F
Fixed Disk 0: TOSHIBR MK3265GSX
House initialized

Figure5-1
POST Screen

Press <F2> to enter SETUF 4

.|
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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The Setup Utility

The Phoenix Setup utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Utility
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Setup Screens

The following pages contain additional advice on portions of the Setup. Z
) ) ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet anc options.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

PhoenixBIDS Setup Utility

N - Main Adranced Security Boot Exit
Figure5-2
. Item Specific Help
Main Menu [[E} 54:17]
System Date: [08717/2010]
<Tab>, <Shift-Tab>, or
b SATA Port 1 [TOSHIBR ME326365X-(] <Enter> selects field.
p SATA Port 2 [TS5Tcorp CDDVDW TS-]
System Memory: 633 KB
Extended Memory: 3838 MB
BIDS Revision: e b ek
EBC/EC Firmmare Revlision: e deded drde
Help Select Item Change Walues Setup Defaunlts
Exit Select Menu Select P Sub-Menu Sare and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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SATA Port 1/2 (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Port 1/2. Use the Auto (Type:) setting to have the
items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

. |
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Advanced Menu

Advanced [TV

PhoenixBI0S Setup Utility
Boot Exit

SATR Mode Selection:

USE BIOS Legacy Support:
Boot-time Diagnostic Screen:
Power on Boot Beep

Battery Low Alarm Beep:

Figure5-3
Advanced Menu

[AHCT]
[Enabled]

[Disabled]
[Disabled]
[Disabled]

Item Specific Help

Help Select Item
Exit Select Menm

Change Walues Setup Defaults
Select FSub-Menu Sarve and Exit

Advanced Chipset Control (Advanced Menu)

The sub-menu here allows you to enable/disable the WLAN Power Setting control.
If enabled then the system will remember the last power status of the Wireless LAN
module e.g. before a restart or shut down.
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SATA Mode Selection (Advanced Menu)

You can configure SATA (Serial ATA) control to operate in either IDE (native/
compatible) or AHCI (Advanced Host Controller Interface) modes from this menu.
The SATA mode should be set to AHCI mode for this system (unless you are sure
your hard disk can only operate in IDE mode). If you are unsure of the mode your
hard disk supports contact your service center. You will need to install the AMD
AHCI driver after installing all the system drivers (see “AMD AHCI Driver” on
page 4 - 7 or “AMD AHCI Driver” on page 7 - 26).

USB BIOS Legacy Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus in
non-USB aware operating systems.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (see “The
Power-On Self Test (POST)” on page 5 - 2).

Power on Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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4

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure5-4
Security Menu

Security Menu

PhoenixBIDS Setup Utility

HMain Advranced Security Boot Exit

Item Specific Help
Supervisor Password Is: Clear
User Password Is: Clear
Swpervisor Password
[IEnt ey | controls access to the
Set User Password [Enter] setup utility.
Passworid on boot: [Di=zabled]
Help Select Item Change Values Setup Defaults
Exit Select Menu Select FSub-Menu Sarve and Exit

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBI1OS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).
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Set User Password (Security Menu)

You can set a password for user mode access to the PhoenixBIOS Setup Utility.
This will not affect access to the computer OS, (only the Setup utility) unless you
choose to set a Password on Boot (see below). Many menu items in the PhoenixBI-
OS Setup Utility cannot be modified in user mode. You can only set the user pass-
word after you have set the supervisor password.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled®), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Boot Menu

PhoenixBIOS Setup Utility

i Main Advanced Securit Boot
Figure5-5 -
Item Specific Help
BOOt Menu Boot priority order:
2: SATA HDD: TOSHIBA MK3I265GSX-{S1) Keys used to view or
3: USB EEY: configure devices:
4: USE HDD: Up and Down arrows
5: PCI BEV: JMC26X Fast Ethernet Contr zelect a device.
[ H <+= amd <-> mbres
7 the device up or down.
8: <%= exclude or include
Excluded from boot order: the device to hoot.
: USE CDROM: <Shift + 1> enahles or
: USB FDC: dizables a device.
: PCI SCSI:
Help Select Item Change Walues Setup Defaunlts
Exit Select Menu Select pSub-Menu Sare and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot priority order. Item specific help on the right is avail-
able to help you move devices up and down the order.

5 - 12 Boot Menu
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PhoenixBIOS Setup Utility H
Main Rdyanced  Security Boot exit Figure 5 - 6
Exit Menu
Item Specific Help

Exit Discarding Changes
Load Setup Defaults Exit System Setup and
Discard Changes save your changes to
Save Changes CHMOS .

Help Select Item Change Values Setup Defaults

Exit Select Menu Select PSub-Menu Sare and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
Exit Menu 5 - 13
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview
Lk
This chapter contains information on upgrading the computer. Follow the steps out- “ .
lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning
tact your service representative for further help. Before you begin you will need: Please check with your
- . i tati
* Asmall crosshead or Phillips screwdriver EZ?(;(‘:; un?g;;iﬁ]nga;xs
» Asmall regular slotted (flathead) screwdriver upgrade procedures to
* An antistatic wrist strap find out if this will VOID
your warranty.
Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo- Bottom Covers
nents. Note that the bottom
cover pictured in this
The chapter includes: chapter is for models
without the 3.75G op-
* Removing the Battery tion. If your model in-
« Upgrading the Hard Disk Drive C'U‘;ef tl:'e tr?JSG
. . - modadule option en a
. Upgrad!ng the Optical (CD/DVD) Device small cover to enable
* Upgrading the System Memory (RAM) you to access the mod-
. . ule’s USIM card will be
Please make sure that you review each procedure before you perform it. included.

. |
Overview 6 - 1
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* You don’t have all the necessary equipment

* You’re not in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2MN\L
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.



Upgrading The Computer

Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’Zl‘ .

it is best to remove the battery. Warranty Warning
Turn the computer off, and turn it over. Please check with your
Slide the latch @ in the direction of the arrow. service representative

Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any

Slide the battery out in the direction of the arrow @. ?pgradf'f%qced'“n\a/sbltg
Ind out | IS WI

PwnE

your warranty.

Figure 6 -1
Battery Removal

Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive

SN
’Ll\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
HDD System disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your
SUELLIRE operating system’s installation instructions, and install all necessary drivers and util-

N Rl el ties (See “Driver Installation” on page 4 - 2), when setting up a new hard disk.
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.

You have all the discs re-
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

6 - 4 Upgrading the Hard Disk Drive
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws @ & @.
3. Remove the hard disk bay cover @.

Figure 6 - 2
Hard Disk Bay
Cover Removal

Upgrading the Hard Disk Drive 6 - 5
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4

Hard Disk Screws &
Cover

The hard disks and cov-
ers pictured here may
appear slightly different

from your model design
(these designs are sub-
ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.

Figure 6 - 3
Hard Disk Removal

No A

Grip the tab and slide the hard disk in the direction of arrow @.

Lift the hard disk out of the bay @.

Remove the screw(s) @ - @ and the adhesive cover .

Reverse the process to install a new hard disk drive (do not forget to replace all the
screws and covers).

6 o

6 - 6 Upgrading the Hard Disk Drive



Upgrading the Optical (CD/DVD) Device e

1.

2.
3.

Turn off the computer, and turn it over and remove the battery.
Locate the component bay cover and remove screws @ -

Upgrading The Computer

/2 \Y

Fan Cable & Cover

Carefully (a fan and cable are attached to the under side of the cover) lift up Make sure you recon-

the bay cover.

nect the fan cable 5

Carefully disconnect the fan cable @), and remove the cover @. before screwing down

the bay cover. Note the
information on replac-
ing the RAM & CPU
bay cover in

Figure 6 -4
Removing the
Component Bay
Cover

Upgrading the Optical (CD/DVD) Device 6 - 7
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5.  Remove the screw at point @), and use a screwdriver to carefully push out the
optical device at point @.
6. Reverse the process to install the new device.

Figure6-5
Removing the 0 @

Optical Device

6 - 8 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM) e
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO- =
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types). Make sure you recon-

nect the fan cable 5

1. Turn off the computer, and turn it over and remove the battery. before screwing down
2. Locate the component bay cover and remove screws @ - @. 115 2R COELD eI SIS

3. Carefully (a fan and cable are attached to the under side of the cover) lift up !nformat'on gl
ing the RAM & CPU
the bay cover.

. bay cover in
4. Carefully disconnect the fan cable @), and remove the cover @. .

Fan Cable & Cover

(6 Figure 6 - 6
Removing the
9 Component Bay

6 6 Cover

Upgrading the System Memory (RAM) 6 - 9
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5. Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 7.

Figure 6 - 7
RAM Module
Release Latches (7] (8]

6. The RAM module will @) pop-up, and you can remove it.

Figure 6 - 8
RAM Module
Removal @

6 - 10 Upgrading the System Memory (RAM)
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7. Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly /
into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module Cover Pins

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure. model has four cover
10. Pressthe module in and down towards the mainboard until the slot levers click into pins. These pins need to
place to secure the module. be aligned with slots in
11. Replace the bay cover (see sidebar) and screws (make sure you reconnect the the case to insure a
fan cable before screwing down the bay cover). proper cover fit, before
screwing down the bay

cover.

Note that this computer

Figure 6 -9
Component Bay
Cover Pins

12. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

.|
Upgrading the System Memory (RAM) 6 - 11
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Chapter 7. Modules & Options

Overview

This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

¢ Wireless LAN Module * AMD AHCI Driver
e PC Camera Module * Bluetooth Module
e 3.75G/HSPA Module

3N
PR

Important Notice

If your purchase option includes both Wireless LAN and 3.75G/HSPA modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance require-
ments, the antenna must not be co-located or operate in conjunction with any other antenna or trans-
mitter.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause in-
terference. When the 3.75G/HSPA module is powered on, make sure that the Bluetooth/Wireless LAN
modules are powered off.

Modules & Options

2NZ
&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

4

Driver Installation &
Module Power

Make sure any modules
(e.g. WLAN, PC Camera,
3.75G/HSPA & Bluetooth
modules) are ON before in-
stalling the appropriate
driver.

Overview 7 - 1




Modules & Options
Wireless LAN Module

AL
’Q‘ If you have included a 802.11b/g/n WLAN module in your purchase option, make

Wireless Device sure that the Wireless LAN module is on before installing the driver.
Operation Aboard

AlfCratt Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1

WCEEEE A c D - 9) to toggle power to the Wireless LAN module. Make sure you install the drivers

S B R BIEER R in the order indicated in Table 4 - 1, on page 4 - 3.
vices aboard aircraft is usu-

ally prohibited. Make sure
GECEREORERCIESSE  802.11b/g/n Driver Installation

you are using the computer

aboard aircraft. 1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).

Click Option Drivers (button).

Click 1.Install Wireless Lan Driver > Yes.
Choose the language you prefer and click Next.
Click Next > Install.

Click Finish to restart the computer.

ISR e N

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see overleaf).

7 - 2 Wireless LAN Module
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on. e

1. Click the taskbar wireless icon lll, and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center
you want to connect to in the taskbar menu (a list of options will appear allowing

setting changes, and creating a new network). LSl el U e bl

work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 -1
Click Taskbar Icon
Menu & Network
and Sharing Center

Wireless LAN Module 7 - 3
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure 7 - 2
Network Location
Set

7 - 4 Wireless LAN Module
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5. Click the taskbar icon 4| to see any currently connected networks.
f : : . . \ A/
6. To disconnect from the wireless network you can click the taskbar wireless icon ﬂ:

.M, click the active connection and then click Disconnect (button). Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 3
Click Taskbar Icon
Menu - Disconnect

Wireless LAN Module 7 - 5
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™ Windows Mobility Center

2§ The Windows Mobility Center control panel provides an easy point of access for
Wireless Hot Keys information on battery status, power plans used and wireless device status etc.

WSSl To access the Windows Mobility Center:
function keys will not func-

tion properly if Wireless is 1. Click Start, and click Control Panel (or point to Settings and click Control

turned OFF in the Win- Panel).

dows  Mobility ~Center 2. Double-click Windows Mobility Center (Mobile PC).

BRIl [FEE 3. Click the button to Turn wireless off/on, or click the icon . to access the network

The wireless indicators menu.

I nay show that
the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on.

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 7 - 4
Windows Mobility

Center : . . .
Make sure Wireless is ON to ensure proper function key behavior.

7 - 6 Wireless LAN Module
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PC Camera Module

SN
Before installing the PC Camera driver, make sure that the optional PC Camera is ’Q\
on. Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on Latest PC Camera
page 1 - 9) to toggle power to the PC Camera module. Make sure you install the R UMERUICIIEREL

drivers in the order indicated in Table 4 - 1, on page 4 - 3. Check the Device Driv-
ers & Utilities + User’s

There are a number of different camera modules available with this computer model [ GaEEEE R UL RED

series. You will have the appropriate application installed for your camera. Make

accompanying insert
Rt - pages, for the latest up-
sure you access the application via the desktop shortcut. dated information on the
PC Camera driver,
which may override the
information provided
here.

. |
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PC Camera Screen
Refresh

The PC Camera module
supports a frame rate of
12 fps. If you find that
the screen refresh rate
is subject to lag or stut-
tering, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.

PC Camera Driver Installation

Use the Fn + F10 key combination to turn the camera module on.

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 2.Install Camera Driver > Yes.

Click Next > Next > Install > Finish to restart the computer.

OR

Click Next > Finish to restart the computer.

OR

Click Next > Install > Finish to restart the computer.

OR

Click Next > Install > Finish > Finish to restart the computer.

Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).

7 - 8 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (VIA High Definition Audio) and make sure the item is not
disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

7. Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

Go to the Devices menu heading and select Microphone (VIA....) (it should have
a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

PoNE

o o

© ©

. |
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Figure 7 -5
Audio Setup for PC
Camera

Right-click/

7 - 10 PC Camera Module



Camera Application
The camera application is a video viewer for general purpose video viewing and test-
ing, and for capturing video files to .avi format.

1. Runthe camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see Set Capture File below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 9) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start
capturing the video, and press Esc to stop the capture (you can view the file using
the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open/Save, then
set the “Capture file size:” and click OK. You can then start the capture process as
above.

Note the important information in “Reducing Video File Size” on page 7 - 12 in or-
der to save file space, and help prevent system problems.

PC Camera Module 7 - 11

Modules & Options

4

Pre-Allocating File
Space

You may pre-allocate the
file size (File > Allocate
File Space) for the cap-
ture file in the camera ap-
plication.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
12.
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to a location other than the C: drive (see “Set Cap-
ture File” on page 7 - 11), limit the file size of the captured video (see “Pre-Allo-
cating File Space” on page 7 - 11) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

7 - 12 PC Camera Module
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to ;Il’;

adjust the setting in the Video Capture Filter options. Latest PC Camera

1. Run the camera application from the desktop shortcut. Driver Information

2. Goto Options and scroll down to select Video Capture Filter.... N T
3. Click either 50Hz or 60Hz under Anti Flicker/Frequency/Powerline Frequency. ers & Utilities + User’s

Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure 7 - 6

© © Video Capture Filter

PC Camera Module 7 - 13
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Zoom (not applicable to all camera modules)

The camera program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.

] 2. Goto Zoom and select Zoom Out/Zoom In.
Figure 7 -7

Zoom/Setting

%
s Taking Still Pictures
Snapshot Folder

The WebCam program allows you to take still pictures.

The Snapshot folder’s de- L
T 1. Run the camera application from the desktop shortcut.

top. Do not move this folder 2. Go to Options and select Take Picture/Snapshot.
Oor an error may appear 3. The picture (in JPEG format) will be placed in the Snapshot folder on the

when you try to take a still desktop (see sidebar).
picture.

If you accidentally delete or
move the folder, you can
create a new Snapshot
folder on the desktop in or-
der to capture the files.

7 - 14 PC Camera Module
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3.75G/HSPA Module

If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
(see “Communication” on page C - 3 for specification details) in your purchase op-
tion, you will have the appropriate application (Mobile Partner) provided for your
particular module. Follow the instructions on page 7 - 16 to install the USIM card
(which will be provided by your service provider), and then install the application.

AN
I

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
guency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

|
3.75G/HSPA Module 7 - 15



Modules & Options

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 3).
. 2. Locate the 3.75G USIM card cover and loosen screw @, and then remove the
Figure 7-8 USIM card cover @.
USIM Card Cover
Removal

¢ o

7 \Y

Power Safety
Warning

Before you undertake any 9
installation procedures,

make sure that you have

turned off the power, and 3. Insert the USIM card as you would into your mobile phone.

CIEEEINERCEREUREEIEE] 4, Slide the SIMLOCK towards the hinge in order to release the lock and lift it up.

S e BB RUEREEIEEE 5 |nsert the USIM card as illustrated in (Figure 7 - 9) and close the SIMLOCK.
telephone lines). It is advis-

able to also remove your
battery in order to prevent
accidentally turning the ma-
chine on.

Figure 7 -9
Insert the USIM Card

7 - 16 3.75G/HSPA Module
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6. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 10 until
it clicks into the lock position.
Figure 7 - 10
SIMLOCK Lock

4

3.75G/HSPA
Modules & System
Wake Up

Note that the 3.75G
modules DO NOT sup-
port system wake up on
3.75G/HSPA  modem
activity.

|
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see Table 1 -4, on
page 1 - 9) to toggle power to the 3.75G/HSPA module. When the 3.75G/HSPA
module is powered on, the indicator will briefly be displayed. Make sure you in-
stall the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Note that exiting
the application does NOT turn off the 3.75G/HSPA module.

* Mobile Partner - See “Mobile Partner Application Installation” on page 7 -
19 for driver installation information and “Mobile Partner Application” on
page 7 - 20 for instructions on using the Mobile Partner application.

7 - 18 3.75G/HSPA Module



Mobile Partner

With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1.

w

|
3.75G/HSPA Module 7 - 19
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key combination (give
will

Enable power to the module by pressing the Fn +
the module about 10 seconds to power on - the on screen icon
indicate the module’s power status).

If a Found New Hardware window appears, click Cancel (click Cancel for
all Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’s Manual disc into your exter-
nal optical device drive.

Click Option Drivers (button).

Click 3.Install 3G Driver > Yes, and then click Next.

Choose the language you prefer and click OK > Next.

Click I Agree (button) to accept the license agreement.

Click Next > Install.

Click Finish.

. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile
Partner icon on the desktop.

Modules & Options

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see

/

).
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Mobile Partner Application

e You will need to contact your service provider to obtain the exact details of how ex-

Mobile Partner Help actly to configure the settings on this page.

To get help on Mobile | Profile Management

Partner  configuration 1. Power on the 3.75G/HSPA module using the Fn +  key combination.
and settings, click the & 2 Access the Mobile Partner application from the Start menu (Start > Programs/
Help menu and select All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
Online Help or press on the desktop
Fl. 3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.
4. Click New and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.

Figure 7 - 11
Profile Management

|
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Connecting to the Service Provider

1. Power on the 3.75G/HSPA module using the Fn + key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect to begin the connection process.
Figure 7 - 12
Connect
5.  The Mobile Partner application will then display the connection information.
Figure 7 - 13
Network

Connection Prompt

|
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6. When the connection is successful you can move the cursor over the network icon
in the taskbar to display the connection information.

Figure 7 - 14
Connected
Taskbar
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons and a network icon in the taskbar .
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9. To disconnect click the Disconnect icon, or right click the taskbar icon
and select Disconnect.

Figure 7 - 15

O O Disconnect

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn + key combination
to turn it off.
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12. If you click the Mobile Partner close icon a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure 7 - 16
Exit Prompt

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn + key combination to turn off
the module (pay careful attention to this aboard aircraft - see “Wireless Device
Operation Aboard Aircraft” on page 7 - 19).

14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted;
the module will be off when the computer starts up.

o If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.

|
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Text Messaging Service

In addition to standard internet services you may also send and receive SMS text
messages using the Mobile Partner program, if your service supports SMS.

Reading SMS Messages

1. Anicon =] will blink at the bottom of the Mobile Partner interface to notify you of
any new messages received.

2. Click the Text icon in the Mobile Partner Interface.

3. Select the Local > Inbox or SIM/USIM Card folder and select any message to
read it.

4. Right-click the message and choose an option to reply, forward or delete the
message.

Creating and Sending SMS Messages

1. Click the Text icon in the Mobile Partner Interface.

2. Click the New button [=].

3. Enter the recipient’'s number in the Send To... field or click the Send To... button to
select an entry from the phone book, and click OK.

4. Type in the message details.

5. Click the Send button, Save button to send the message later or Close > Yes to
save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SMS.

|
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AMD AHCI Driver

If you have enabled AHCI mode in the BIOS (see “SATA Mode Selection (Ad-
vanced Menu)” on page 5 - 9), and have not installed the AHCI driver at system in-
stallation, then you should do so now as per the instructions below:

1.

ok wn

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 4.Install AMD AHCI Driver > Yes.

Click Next > Install.

Click Finish > Finish to restart the computer.

Click OK to reboot the system after the driver has been installed and the
system restarted.

To uninstall the AMD AHCI driver see the instructions in “Uninstalling the
AMD AHCI Driver” on page 8 - 12.

7 - 26 AMD AHCI Driver



Modules & Options

Bluetooth Module

There are two Bluetooth module options available for this computer. If your pur- Wireless Device
chase option includes the Combination Wireless LAN & V3.0 Bluetooth module e
then install the driver as instructed overleaf (see “Bluetooth & WLAN Combo Set- Aircraft

tings” on page 7 - 29 for configuration instructions).

2N
2§

The use of any portable

If your purchase option includes a standard V2.1 Bluetooth module, then the op- S B EEES

erating system’s Bluetooth Devices control panel is used to configure the Bluetooth ally prohibited. Make sure
settings in Windows 7, and therefore does not require a driver (see “Standard Blue- the module(s) are OFF if

tooth Configuration in Windows 7”” on page 7 - 36). e N

Use the Fn + F12 key combination to toggle power to the Bluetooth module (see S IS A
ination to toggle power to

“Function Keys & Visual Indicators” on page 1 - 9). When the Bluetooth module is the Bluetooth module, and

powered on the indicator will briefly be displayed. check the LED indicator to
see if the module is pow-

ered on or not (see

/

Z )

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a

file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.
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4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & V3.0 Blue-
tooth module supports
high speed (V3.0) data
transfer. However to
achieve such transfer
speeds, both devices
must  support high
speed data transfer.

Check your Bluetooth
compatible device's doc-
umentation to confirm it
supports high speed data
transfer.

Bluetooth Combo Driver Installation
Note this driver is required only for the combo Bluetooth and WLAN module only.

1.

Nooks~wn

o

10.

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 5.Install Combo BT Driver > Yes.

Choose the language you prefer and click OK.

Click Next.

Click the button to accept the license and click Next.

Click Next > (select if you want to create an icon to appear on the desktop)
Next > Install.

Click Finish.

The My Bluetooth icon  will appear on the desktop and the Bluetooth
item will be installed in the Programs/All Programs menu.

See “Bluetooth Networking Setup” on page 7 - 32 for information on
Bluetooth networking.
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Bluetooth & WLAN Combo Settings

This information applies to the combo Bluetooth and WLAN module only. e

Bluetooth Module &

1. Make sure the Bluetooth module is powered on. Resuming From Sleep

2. Double-click the My Bluetooth application on the desktop (or access it from the Mode
Programs/All Programs menu).
3. Click My Bluetooth Settings (menu heading). The Bluetooth module’s de-

fault state will be off after re-

suming from the Sleep
power-saving state. Use the
key combination (Fn + F12)
to power on the Bluetooth
© module after the computer

resumes from Sleep.

Figure 7 - 17
My Bluetooth
Settings
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4. Click General Settings to change the computer name that other Bluetooth
devices will see, and click the tickbox to Allow Bluetooth devices to find this

computer
5. Click OK to confirm the settings.

Figure 7 - 18
General Settings

I
I

<
llll
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6. Click File Transfer Settings to Enable sharing of my files with other

Bluetooth devices.
7. Click OK to confirm the settings.

Figure 7 - 19

< > File Transfer

Settings
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Bluetooth Networking Setup
This information applies to the combo Bluetooth and WLAN module only.

1. Make sure the Bluetooth module is powered on.

2. Double-click the My Bluetooth application on the desktop (or access it from the
Programs/All Programs menu).

3. Click My Bluetooth Settings (see Figure 7 - 17 on page 7 - 29).

>

Figure 7 - 20
Network Settings

Click Network Settings (make sure the Bluetooth module is powered on.

Click Enable Bluetooth Network and click OK.

A message will appear in the taskbar to confirm that the network driver has been
installed.

SRS

. |
7 - 32 Bluetooth Module



Modules & Options
Bluetooth & WLAN Combo Module Configuration

This information applies to the combo Bluetooth and WLAN module only. e

. o Bluetooth Module &
Setup your Bluetooth Device so the Computer Can Find it Resuuemoigg Fr(;)muSTeep
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Mode

2. Make the device discoverable (to do this check your device documentation).
The Bluetooth module’s de-

To Turn the Bluetooth Module On e efzr vl e @i ey -

. . suming from the Sleep

1. Pressthe Fn + F12 key combination to power on the Bluetooth module. power-saving state. Use the

. key combination (Fn + F12)

To Add a Bluetooth Device to power on the Bluetooth

1. Double-click the My Bluetooth application on the desktop (or access it from the module after the computer
Programs/All Programs menu). resumes from Sleep.

2. Double-click the device you want to pair with the computer (if no devices appear
press F5 or click the Refresh button to search for devices).

Figure 7 - 21
My Bluetooth
Devices

. |
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3. You will then be presented with a menu of options to select from.

Figure 7 - 22

Bluetooth Device
Options

4. Click the appropriate button to connect to the device.
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5.  You may need to allow the connection from your device, and you will then need to
provide a passcode from the device.

6. You can then enter the passcode on the computer and click OK to establish the
connection.

Figure 7 - 23
Bluetooth Pairing
Code & Connection
Established
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Standard Bluetooth Configuration in Windows 7

el Setup your Bluetooth Device so the Computer Can Find it
Add a Device 1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

Click Start, and click Con- 2. Make the device discoverable (to do this check your device documentation).

trol Panel and then click § 14 (- the Bluetooth Module On
Devices and Printers

(Hardware and Sound). 1. Pressthe Fn + F12 key combination to power on the Bluetooth module.
Click Add a device to 2. A Bluetooth icon g will appear in the taskbar.

search for any available © 3 You can then do any of the following to access the Bluetooth Devices control
Bluetooth devices.

panel.
Bluetqoth Module & +  Double-click the taskbar icon [3 to access the Bluetooth Devices control panel.
Resumln'\g/gl F(;om Sleep « Click/Right-click the taskbar icon E; and choose an option from the menu.
ode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
tooth module after the com-
puter resumes from Sleep.

Add a device
Figure 7 - 24

Bluetooth Devices & Right-Click Taskbar Icon i3
Click Icon Menu
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device. /
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 25

i . . . _ . Add a Device
3. On first connection the computer will provide you with a pairing code to be entered

onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

Figure 7 - 26 N
Pairing Code Pairing Codes

Example The example outlined here shows a connection to

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

o

Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure 7 - 27
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices. /
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
» Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
To Make your Computer Discoverable to Bluetooth Devices g‘;gzg“;?l"g; :;?3 asﬁg
1. Cl!ck the Faskbar icon and select Open Settings. _ _ _ Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this

. R menu. Type Bluetooth in
computer check box (Discovery) has a tick inside it. the Search Help box, and

3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a tick inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.

Figure 7 - 28
Bluetooth Settings -
Options

Bluetooth Module 7 - 39



Modules & Options

40



Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 6) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)”” on page 5 -
2).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

\ A/
LS
Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more

system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using a
USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Energy Star Power Saving” on page 3 - 10).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 12). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix B for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 9) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers appear when
typing.

If the LED ﬁl is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 6).
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Problem Possible Cause - Solution

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

The system freezes or the screen goes | The system’s power saving features have timed-out. Use the AC/DC adapter,
dark. press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power | Power Options features are not enabled. Go to the Windows Power Options

saving mode. menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3.75G/ | The modules are off. Check the LED indicator {‘l’) and/or function key indicator
HSPA modules cannot be detected. to see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 6). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn + (3.75G/HSPA) key combination(s)
in order to enable the modules (see Table 1 - 4, on page 1 - 9).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on pagel - 9). Run the
BisonCap program to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

The Wireless LAN indicators
show that the WLAN module is powered
on, however the module does not connect.

The WLAN module is turned off in the Windows Mobility Center. The
computer’s wireless function keys will not function properly if Wireless is turned
OFF in the Windows Mobility Center control panel. Make sure that Wireless is
ON in the Mobility Center to ensure proper function key behavior (see
“Windows Mobility Center” on page 7 - 6).
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Uninstalling the AMD AHCI Driver
Uninstalling the AMD AHCI driver is a two part process. Follow the instructions below if you need to uninstall
the diver for any reason.

Go to the Windows control panel.

Click Device Manager (Hardware and Sound > Devices and Printers).
Click the arrow next to IDE ATA/ATAPI controllers to open the sub-menu.
Double-click AMD SATA controller.

Click Driver (tab) and click Uninstall.

Click to select “Delete the driver software for this device.” and click OK.

oukrwdpE

>
>

Figure 8 - 1 - Device Manager - Uninstall AMD SATA Controller
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7. Click Yes to restart the computer.

8. Click Restart Now to restart the computer again.

9. After the computer has restarted return to the Windows control panel.
10. Click Programs and Features (Programs).

11. Click AMDSata and click Uninstall > Yes.

12. Click Finish and close the control panel.

Figure 8 - 2 - Uninstall AMDSata (Programs and Features)
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PwDNPE

o

2¥ MNetwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
5;-“ Bluetooth Device (RFCOMM Protocol TDI)

A

Bluetooth Peripheral Devices

l;‘ Marvell Yukon 88E8040 PCI-E Fast Ethernet Contreller You will need to repeat the procedure
4-llp Other devices : listed here for all Bluetooth Peripher-
i 4|7 Bluetooth Peripheral Device q A q

W PCIFLASH Memory .a| DeV|.ces listed under Other Devices
o) Processors i.e. until there are no more Bluetooth
>~ Sound, video and game controllers Peripheral Devices listed under this
P - Storage controllers menu heading_

ol Suertarn Asicar

Figure 8 - 3 - Device Manager

. |
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 4 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

>

Figure 8 - 5 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ || Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
disk that centains the driver you want to install, click Have Disk.

Manufacturer “ || Model
B Microlink Wwwice support
Make sure you select R —

. 3 Microsoft Corporation
Microsoft Corporation

e Toess

MAT o Cio.

(5] This driver is digitally signed.

Tell me why driver signing is important

N
Ciee D[ Gancel |

Figure 8 - 6 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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Troubleshooting
15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth

Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

>

Figure 8 - 7 - Device Manager - Bluetooth Radio

. |
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Wake On LAN Setup

Wake On LAN is an Ethernet computer networking standard that allows a computer to be turned on or woken
up by a network message. If you need to have your computer Wake On LAN you will need to enable Computer
Management settings as follows.

Go the Windows control panel and double-click Administrative Tools (System and Security).
Double-click Computer Management.

Click Device Manager under System Tools, and click the arrow to the left of Network adapters.
Double-click jMicron PCIExpress Fast Ethernet Adapter, and click Power Management (tab).
Click to enable (place a check in the checkbox) “Allow this device to wake the computer”.

agrwnE

>

P < &

< >

>

Figure 8 - 8- Network Adapter Wake On LAN (Power Management)
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8.
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Troubleshooting
Click Advanced (tab).
Scroll down to the bottom of the Property menu and select “Wakeup from Shutdown”.
Click to select Enabled from the drop-down Value menu.

. Click OK to close the menu.
0. Close the Computer Management control panel.

D

>

>

Figure 8 - 9- Network Adapter Wake On LAN (Advanced)
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack

Plug an external microphone in to this jack to record on your computer.
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Item Description

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).
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ATI Video Driver Controls

Appendix B: ATl Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on

page 1 - 13. 4
. . . Video Card

ATI Video Driver Installation Options
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Note that card types,
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers specifications and driv-
(button) ers are subject to con-

' tinual updates and
1. Click 1.Install Video Driver > Yes. changes. Check with

. our service center for
2. Click Next > Install (button). ¥he latest details on

3. Click the Express (or Custom if you prefer to manually configure the video cards supported.
driver installation settings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish > Yes to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.
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ATI Video Driver Controls

4

ATI Taskbar Icon

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon in the taskbar
(or by right-clicking the icon
and selecting Catalyst
Control Center).

If you don’t see the ATl icon
in the taskbar, click Op-
tions > Preferences (tab)
in the ATI Catalyst® Con-
trol Center, and select En-
able System Tray Menu
(see Figure 1 - 8 on page
1-14).

Right-click the ATl icon
to bring up the taskbar
menu.

FigureB -1
ATI Catalyst Control
Center Basic Settings

ATI Catalyst® Control Center

Adjust the video settings from the ATI Catalyst® Control Center.

1. Open the ATI Catalyst Control Center (see page 1 - 13).

2. Click Advanced (button).

3. A wizard will help you set up the display options, or you can click Advanced
(button) to go to the ATI Catalyst Control Center (you can change the options
from the Basic menu or the View menu in the ATI Catalyst Control Center).

4. Note that the Advanced options are featured in this chapter (if you choose Basic
the on-screen Wizard will help you configure your display options)

Click Advanced Button to go to
the ATI Catalyst Control Cen-
ter. You can change the options
from Advanced to Basic by
clicking the appropriate button.

Note that the control panels pic-
tured in the following pages are
from the Advanced settings.

>
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The ATI Catalyst® Control Center provides additional video configuration con-
trols and tools which allow quick access to features such as display options, 3D Set- 4
tings, color and Help menus etc. Adjust settings from the Graphics and Options
menus at the top of the control panel.

Help Menus

Click the Help icon

and select an option
from the drop down
menu. Press F1 to bring
up Help for any current-
ly selected page.

Figure B - 2
ATI Catalyst Control
Center Advanced
Settings
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4

Function Keys

You can use the Fn + F7
key combination to toggle
through the display options:

* Notebook Only

« External Display Only

* Notebook + External
Display

Give the displays enough

time to refresh.

Other Applications

If you are using a third party
application to play DVDs
etc. you will need to consult
the application’s documen-
tation to see the appropri-
ate audio configuration (the
application must support
digital to analog transla-
tion).

Attaching Other Displays

Besides the built-in LCD, you can also use an external monitor/flat panel display as
your display device. The following are the display options:

» The built-in LCD.
» An external monitor connected to the external monitor port/HDMI-Out port.
» A flat panel display connected to the external monitor port/HDMI-Out port.

HDMI Notes
» Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.

2. Configure your external display as per the instructions provided on the following
pages.

3. Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

4. You can now play video/audio sources through your external display.

See “HDMI Audio Configuration” on page B - 14 for more information on the au-
dio settings for HDMI.
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Display Modes

Single
Only one of your displays is used.

Duplicate

Duplicate simply shows an exact copy of the Main display desktop on the other dis-
play(s). This mode will drive multiple displays with exactly the same content, reso-
lution, refresh rates and color quality etc.

Extend

Extend treats both connected displays as separate devices, and they act as a virtual
desktop resulting in a large workspace. When a display is Extended, you can drag
any icons or windows across to the other display desktop. It is therefore possible to
have one program visible in one of the displays, and a different program visible in
the other display.

Attaching Other Displays B - 5
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4

Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

Figure B -3
Desktops &
Displays

Configuring an External Display using the ATI CCC
You can use the ATI Catalyst Control Center to configure any attached displays.

Attach your external display to the external monitor port/HDMI-Out port and turn it
on.

2. Open the ATI Catalyst Control Center.

3. Select Desktops & Displays from the Graphics menu in the top left of the screen.

4. Attached displays will appear in the lower part of the screen (click Detect Displays
to find any attached displays that do not automatically appear).

5. Right-click the attached display icon to bring up the options.

6. Select an option from the menu, and click Yes to accept the settings.

7. Click OK to save the changes.

Attached displays will appear here.
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ATI CCC - Switching Display Modes

1. Attach your external display to the external monitor port/HDMI-Out port and turn it
on.

2. Open the ATI Catalyst Control Center.

Select Desktops & Displays from the Graphics menu in the top left of the screen.

4. Attached displays will appear in the lower part of the screen (click Detect Displays

to find any attached displays that do not automatically appear).

Right-click the attached external display icon and select Disable.

Click Yes to accept the settings.

7. After the external display has been disabled right-click the attached external
display icon again.

w

ou

Right-click and FigureB-4
select Disable. Desktops &
Displays (Disable)
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o

Select Duplicate or Extend from the menu.
9. Click Yes to accept the settings.

10. If you need to change the display mode then disable the external display and
configure as outlined here.

Figure B -5
Desktops &
Displays
(Extend Mode)

B Right-click and select either Duplicate or Extend.
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Configuring an External Display in Win 7

1. Attach your external display to the external monitor port/HDMI -Out port and turn it on.

2. Go to the Screen resolution control panel (see “Video Features” on page 1 -
13).

3. Click the Detect button.

4. The computer will then detect any attached displays.

Figure B - 6 -
Screen Resolution
Multiple Displays
(Win 7)

5. You can configure the displays from the Multiple Displays menu.

.|
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6. Click Apply to save any setting changes.

Figure B - 7 -
Screen Resolution
Multiple Display
Options
(Win 7)

» Duplicate these displays - Shows an exact copy of the main display desktop on

the other display(s)
» Extend these displays - Treats both connected displays as separate devices

» Show desktop only on 1/2 - Only one of your displays is used.

.|
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Using the Windows Logo Key & + P Key Combination to Switch Displays

You can also use the & + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

Attach your external display to the external monitor port and turn it on.

Press the & + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or s + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PoNPE

FigureB -8
s + P Display
Configuration

Selection
(Win 7)

.|
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Theater Mode

Theater Mode enables you to display video playback in full screen on a secondary
monitor. Theater Mode can be configured from the Avivo™ Video > Theater Mode

tab in the Graphics Settings Tree View pane.

Figure B-9
Theater Mode

. |
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PowerPlay ™

PowerPlay™ in the AT1 CCC allows you to set your graphics processor settings for
higher performance or longer battery life.

Figure B - 10
PowerPlay™

PowerPlay™ B - 13
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HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
Configure the audio output as per the instructions below.

FigureB - 11
Sound - HDMI
Device
(Set Default)

1
2.
3.
4

Connect a device with HDMI support to the HDMI-Out port.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound), and click Playback (tab).

Click to select the connected HDMI device and click Set Default (or right-click the
icon and select Set as Default Device).
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5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.
6. Click OK to close the control panel (see notes overleaf).

Figure B - 12
HDMI Device
Properties
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4

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).

ATI Video Driver Controls

HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1.
2.

3.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page B - 4.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

.|
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Appendix C: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

AMD® Athlon™ x2 Dual Core 14.0” (35.56cm) 16:9 HD (1366 * 768) One Changeable 12.7mm(h) Super Multi
Processor: TFT LCD Optical Device Drive (CD/DVD) with SATA
QL62 (2.0GHz) Interface

65nm (65 Nanometer) Process One Changeable 2.5" 9.5 mm (h) HDD

Technology, 1MB L2 Cache & 667MHz Two 200 Pin SO-DIMM Sockets with SATA (Serial) Interface
FSB - TDP 35W - (638-pin) Micro--PGA Supporting DDRII (DDR2) 800MHz (Real _
Package - Socket-S1G2 Frequency depends on the FSB of
Processor) High Definition Audio
AMD® Athlon™ Single Core Memory Expandable up to 4GB (using Direct Sound 3D™ Compatible
Processor: 1GB/2GB SO-DIMM Modules) Built-In Microphone

Q146 (2.1GHz)

65nm (65 Nanometer) Process
Technology, 512KB L2 Cache & 667MHz
FSB - TDP 25W - (638-pin) Micro--PGA

2 * Built-In Speakers

ATI® Radeon HD3200 On Board Video:

Package - Socket-S1G2 High IPreference 3D/2D Graphic Isolated WinKey Keyboard
Accelerator _ Built-in TouchPad with Multi-Gesture
AMD® Mobile Sempron™ Processor: ??;CTS Memory Architecture of up to Functionality

S140 (2.0GHz)

65nm (65 Nanometer) Process
Technology, 512KB L2 Cache & 667MHz
FSB - TDP 25W - (638-pin) Micro--PGA

Package - Socket-S1G2 One 8Mb SPI Flash ROM
C Phoenix™ BIOS

ATI® RS780MN + SB710

Supports Microsoft DirectX® 10
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Three USB 2.0 Ports

One External Monitor Port
One HDMI-Out Port

One Headphone-Out Jack
One Microphone-In Jack
One RJ-45 LAN Jack
One DC-In Jack

Embedded Multi-In-1 Card Reader
- MMC / RSMMC

- SD/ Mini SD

- MS / MS Pro / MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Two Mini-Card Slots with PCle (Slot 1) &

Specifications

3.75G Module:

USB (Slot 2) interface:

Slot 1 for Half Mini-Card WLAN Module
Slot 2 for 3.75G Mini-Card Module
(Factory Option)

Built-ln 270Mb/100Mb Base-TX Ethernet
LAN

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module with PCle Interface(Option)

300K Pixel PC Camera Module with USB
interface (Factory Option)

1.3M Pixel PC Camera Module with USB
interface (Factory Option)

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module (Factory Option)

Combo WLAN (802.11b/g/n) and
Bluetooth v3.0 Half Mini-Card Module

with PCle Interface (Factory Option)

UMTS/HSPDA-based 3.75G Module with
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Supports Wake on LAN
Supports Wake on USB

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 19V, 3.42A or 18.5V, 3.5A (65
Watts)

Removable 6 Cell Smart Lithium lon Battery
Pack 48.84WH

2nd Battery 6 Cell Smart Lithium lon Battery
Pack 62.16WH (Option)

Specifications C - 3




Specifications

Security (Kensington® Type) Lock Slot
BIOS Password

Windows® 7

Temperature

Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

340mm (w) * 238mm (d) * 13.9 - 31.8mm (h)
2.2 kg with 6 Cell Battery Pack
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